


Using R, spsurvey, and Tinn-R
for Monitoring Design and Analysis

The purpose of this document is to describe how to acquire and install software necessary
for selecting sites as part of the design of a monitoring program and for completing
statistical analyses of the subsequent data. By following the instructions, a reader can
expect to have the software ready to use and to have a very brief introduction on how to
use it.

What is R?

R is a language and environment for statistical computing and graphics. It is based on the
S language and environment which was developed at Bell Laboratories (formerly AT&T,
now Lucent Technologies) by John Chambers and colleagues. R provides a wide variety
of statistical (linear and nonlinear modelling, classical statistical tests, time-series
analysis, classification, clustering, ...) and graphical techniques, and is highly extensible.
The S language is often the vehicle of choice for research in statistical methodology, and
R provides an Open Source route to participation in that activity. R is available as Free
Software and runs on Windows.

R is an integrated suite of software facilities for data manipulation, calculation and
graphical display. It includes

an effective data handling and storage facility,

a suite of operators for calculations on arrays, in particular matrices,

a large, coherent, integrated collection of intermediate tools for data analysis,
graphical facilities for data analysis and display either on-screen or on hardcopy,
and

o awell-developed, simple and effective programming language which includes
conditionals, loops, user-defined recursive functions and input and output
facilities.

The ability to add new statistical algorithms, through user-developed libraries, is one of
its greatest features. This is a major reason for our use of R.

Why use R for Aquatic Monitoring Survey Design and

Analysis

e Needed way to provide survey design and survey analysis algorithms to others
(particularly states and tribal nations)

¢ No existing statistical software has the algorithms required

e Many organizations have limited ability to purchase any recommended
commercial statistical software

e Risfree, easily installed, and usable with training

e Our approach is to provide libraries that minimize knowledge required about R
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Joint use of R, spsurvey and Tinn-R

To use R for monitoring survey design and analysis requires a specific R library —
spsurvey — developed by the ARM Design Team. Both R and spsurvey can be
downloaded from the ARM web site. spsurvey uses another library developed by others
and is also available from the ARM web site. No additional software is required. We
have found it useful to use another program, a text editor Tinn-R, which has been
designed to work with R. 1t can also be downloaded from the ARM web site.

Acquiring R, spsurvey, sp, and Tinn-R

Rather than have users go to several different web sites to download R, spsurvey, and

Tinn-R, we have made them accessible from the ARM web site. This also allows us to

make sure that the software versions are compatible. If you want to download R or other

libraries for R from the R website, see the appendix. To download from ARM website:
e Go to http://www.epa.gov/nheerl/arm/ and click on “Download Software” in the

left column (or go directly to:

http://www.epa.gov/nheerl/arm/analysispages/software.htm)
2 Aquatic Resource Monitoring - Microsoft Internet ... |'__HE\8|
File Edit Wiew Favorites Tools Help i

b3

QBack - @ - [¥] [@) €0 Osearch SipFavorites € A~ iz -

Address &1 htp: ffwww epa.gov/nheerlfarm/ ~ | 5o Lirnks @ -
U.S. Environmental Protection Agency %

Aquatic Resources Monitoring

Fecent Additions | Contact Us | Print “ersion | Search

EPA Home = Office of Research Development (ORD) = kational Heatth Environmerntal Effects
Eesearch Laboratory (MHEERL ) = YWestern Ecology Division WWELDH = AR

Aquatic Resource Aquatic B
Monitoring
Site Map Resources
Recent Additi Monitoring Web
ce ons Site

Introduction

Design & Analysis Hosted by the
Monitoring Design
and Analysis Team
USEPA ORD
National Health and

Environmental Effects

Process Overview

Design: How to
GRTS Designs

Analysis: How to Erwvironmental Monitoring and Assessment Program

Download Software Research Laboratory,

Aquatic Resources WESte_I'r:l I_Ecology

B Division,
Corvallis, OR

Lakes

Streams

Wetlands This ¥eb site provides infarmation on monitoring of aguatic resources in the LIS,

prirmarily focused on design and analysis of probahility based surveys. Links are

(P rs provided to other aguatic resources maonitoring information available on the internet.

Indicators
T e Rl e R is designed to provide users needing infarmation in several areas:

I@ . L ocal intranet

e Right click on R-2.15.0-win.exe to download the R windows installer and place
on desktop (may put in any location you wish but remaining instructions assume
it is on your desktop)



http://www.epa.gov/nheerl/arm/�
http://www.epa.gov/nheerl/arm/analysispages/software.htm�

Right click on spsurvey_2.4.zip to download the spsurvey library and place on
desktop (may put in any location you wish but remaining instructions assume it is
on your desktop). Do NOT unzip!!!

Right click on sp_0.9-99.zip to download the sp library and place on desktop (may
put in any location you wish but remaining instructions assume it is on your
desktop). Do NOT unzip!!!

Right click on Tinn-R_2.3.7.1_setup.exe to download the Tinn-R windows
installer and place on desktop (may put in any location you wish but remaining
instructions assume it is on your desktop)

Other files on the Aquatic Resources Monitoring — Software web page are:
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How to install R, spsurvey, and Tinn-R (this document)

A user guide for the spsurvey library

Changes to the spsurvey library

Spatial survey design examples for points, lines, and polygons, i.e., finite, linear,
and areal aquatic resources

At this point all necessary software is now located on your desktop.

Installing R

Uninstall previous versions of R, if any (Not absolutely necessary)

Close all other programs (safety precaution)

Install the downloaded file by double clicking the R-2.15.0-win.exe desktop icon.
It is a Standard Windows installer. You may need to have administrator
privileges to do the install. If so, contact your systems administrator. May take 5-
10 minutes to complete installation

Windows installer goes through series of windows. Recommend that use default
options except for the following two windows:

Startup Options: Specify Yes to customize. Then select SDI option. SDI option
required when use Tinn-R

1 Setup-R for Windows B@@ 16t Setup - R for Windows B@@

Startup options Display Mode
Do you want to custamize the startup options? Do yous prefer the MD! or SO interface? R

Plese specily e or n, then clck Nt Please speciy MDI o SO, then click Nest

iy
() Noaccept defauls]

[ ¢ Back ” Hest> H Cancel ] I < Bark ” Nt » H Lancel l




e Select Additional Tasks (see window below). Have options:
0 Place an R icon on the desktop (check if you want a desktop icon)
o0 Create a Quick Launch icon (check if you want a Quick Launch icon)
0 Save version number in registry (if checked, then you must have
Administrator privileges to uninstall R)
o0 Associate R with .RData files (make sure this is checked)

5 Setup - R for Windows

Select Additional Tasks
Which additional tazks should be performed? R

Select the additional tasks wou would like Setup to perform while installing B for
windows, then click MNext.

Additional icons:
i

Create a Quick Launch icon

Registry entries:
[] Save version number in registry

Associate B with RData files

< Back H Hext > ] [ Cancel

Starting R

R may be started several ways
e Double click the R desktop icon (if created)
e Click the Quick Launch icon in Start window (if created)
e Double click on an “.RData” file created during an R session (more later on
“.RData” files
The window below appears when R is started.

| R Console
Eile Edit Misc Packages Help

ISZEN 3-900051-07-0

F iz free software and comes with ABIOLUTELY MO WARRANTY.
You are welcoms to redistcribute it under certain conditions.
Type 'licensel)]' or 'licence()' for distrikbution details.

Natural language support but running in an English locale

F i= & collasboratiwve project with many contributors.
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Twpe 'contributors()' for mwore information and

'citation()' on how to cite R or R packages in publications.
Twpe 'demo()' for some demwos, 'help()' for on-line help, or
'help.start () ' for an HTHML bhrowser interface to help.

Type 'gf)' to guit E.

|
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Installing R library packages

Two steps are necessary to use an R library: (1) installing the package and (2) loading the
package. Installing a package only is done once. The package must be installed again if
a new version of R is installed. Loading a package must be done every time R is started
and it is required for your analysis.

To install spsurvey or sp libraries that are located on your desktop (or other folder), click
on Packages on main menu and click on Install package(s) from local zip files....
Locate the spsurvey or sp zip file using the dialog windows, select the zip file and click
Open to complete installation. Must do each package separately and must install the sp
package prior to installing the spsurvey package.



I R Console
File Edit Misc NEEEEREN Help

Load package. ..
. I oad package

Set CRAN mirrar, .,
Select repositories, .,
Install packageds). ..
Update packages. ..

Inskall p 3 From local zip il
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Select files

Lok i

by Recent
Documents

Desktop

3

My Documents

g;;

Wy Compiter

\E; R240

V‘ €] v b"

Chin
Qe
Delr
include
Olbrary
2modes
Odre
Qe
aTd

Fike ame: “

i (=

|

st Zolis [ )

v ‘ I Cancel

Select files

Lock in: ‘@ Desktop

by Recent
Documerts

Wy Documents

2

My Computer

v O &Gy

vy Documents
4y Computer
430y Network Places
Backp

& Local Dik (C)
##ocal Disk (D)
5oftware for ARM
0 09220p
@spsurvev_l.él‘zip

File name: “
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To load a package, click on Load package... in the Packages pull-down menu. Then
select the package from the popup window.

bont
class
cluster
datasets
foreign
graphics
grDevices
I R Console EzrdnSmnnth
File Edit Misc [§3 lattice
- MAass
i methods
Type 'demo(  Set CRAN mirror.., or on-line help, or mgcy
'help.start  Select repositories. .. face to help. nime:
Type 'qf)!' Install package(s). .. nnet
|Update packages... rpart
> utils:::n sp
Error in iy Install package(s) from local zip files... tr filters = Filters[e($ spgtial
no packages were specified S|:l|||'|ES
> utils:::menulnstalllocal () Spsurvey
package 'sp' successfully unpacked and MDS suwms checked :E:E;
updating HTHL package descriptions survival
> utils:::menulnstalllocal () kclkk
package 'spsurvey' sSuccessfully unpacked and MDS sums checked tonls
updating HTHL package descriptions Ltils
> logal ({pky <- select.listisort(.packagesiall.availaskhle = TRUES
+ ifinchar (pkg)) librarvipkg, character.only=TEUE) )
B —
v [ Ok ] [ Cancel ]
£ >

Library packages may also be loaded using the R command library(name) where name
is the name of the package (e.g., sp or spsurvey). More about R commands later.

Accessing the R Help System

The Help pulldown menu has several help features. A very useful help feature is Html
Help. It uses your web browser to display help about R, R commands, and R library
packages.

|- R Console
File Edit Misc Packages NgElls

- l Cansole

FaZ on R
Fag on R For Windows
Marnuals (in PDF) »

R Functions (text). ..

Htrml bhelp

Search help...
search.r-project.org ...

Apropos. ..

R Project home page
CRAMN horme page

About
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2 The R Language - Microsoft Internet Explorer |Z||E|FZ|
File Edit Wiew Favorites Tools Help -:,'
» — .1 ] — 3
G Back - \_) |ﬂ @ . ﬂ -~ ! Search “i'\'( Favorites ﬁ‘} <] - .,;’;; IJ_)‘-I - _J ﬂ
Address |@ Ci\Program Files\R4R-2. 4.0 dochtmlyindes . html Vl G0 Links ** '@ -
~

Statistical Data Analysis

Manuals
An Introduction to B The B. Lansuage Definition
Wiiting B. Extensions R Installation and Admmustration
E. Data Import/Export E. Internalsg
Reference
Packages Search Engine & IKevwords

Miscellaneous Material .

About B Authors Resources

@ 3} My Computer

Clicking on Manuals provide access to the R manuals. Clicking on Packages gives a list
of available packages. Clicking on a package name will give a list of commands
available in that package. See two windows below. The second window shows a partial
list of the commands (functions) available in spsurvey.
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A R: Package Index - Microsoft Internet Explorer

File Edit ‘jew Favorites Tools  Help l';
Q Back - [ \ﬂ IELI _;\] /-.- ) search ‘:1\?‘ Favorites @? a1 = ”
Address | € Ci\Program Files\RIR-2 .4, Oldacthtmlipackages. html v B Links * @y~
bage The R Base Paclage =
boot Bootstrap R (S-Plus) Functions (Canty)
class Functions for Classification
cluster Cluster Analysis Extended Rousseeuw ef al.
datazets The R Datasets Paclkage
foreien F.ead Data Stored by Miumtab, S, SAS, SPSS,
Stata, Systat, dBase, ...
graphics The R. Graphics Package
aDevices The R. Graphics Devices and Support for Colours
'_ and Fonts
z arid The Gnid Graphics Package
EKemSmooth Functiong for kernel smoothing for Wand & Jones
L (1995)
E lattice Lattice Graphics
MASS Mam Package of Venables and Ripley's MASS
:' methods Formal Methods and Classes
U‘ mecv GAMs with GCV smoothness estimation and
o GAMM= by REML/PQL
nline Linear and nonlinear nuxed effects models
n nnet Feed-torward Weural Networles and Multinomial
Log-Linear Models
m rpart Recursive Partitioning
> sp claszes and methods for spatial data
= gpatial Functions for Kriging and Point Pattern Analysis
: gplines Regression Spline Functions and Classes
u SpsUIVey Spatial Survey Design and Analysis
m statg The R Stats Paclkage
statsd Statistical Functions vsing S4 Classes
q smvival Survival analysis, mchiding penalised likelihoodl.
teltls Tcl'Tk Interface
q tools Tools for Paclage Development
n utils The R Utils Paclcage 2
m :El Done J My Computer
2
=




A R: Spatial Survey Design and Analysis - Microsoft I... |:Hﬁ\rg|
.}'{r

Eile Edit View Favorites Tools Help
€] Q - ¥ & @ O seach girFavorites € (v dn - )
Address |€1CARVR-2.4.04ibraryispsurveythtmO0Indes. html v Go  Links @ -
b
Spatial Survey Design and Analysis
21D
l_ Documentation for package spsurvey' version
z 1 - 5
Ll User Guides and Package Vignettes
E Eead overnew or browse directory.
: Help Pages
o adywat Adust Initial Survey Design Weights
albersgeod Project Albers Projection in Plane to Spheroid
a cat. analysis Categoncal Data Analysis for Probability Survey Diata
category. est Category Proportion and Size Estimates
m cdf decon Churnulative Dhistribution Function - Deconvolution —
} codf est Currlative Distribution Function - Estimation
cdf test Churrlative Distribution Function - Inference
l I cont analysis Contimious Data Analysis for Probability Survey Data
I dsgnsum Summarize the Sites Selected for a Survey Design
i ’ eco 13 ut Example Polygons Dataset
framesum Summarize Frame 5ize for a Survey Design
m orts Generalized Random-Tessellation Stratified (GETS) Survey Design
q sarea Select GRTE Sample of an Area Eezource
grtshin Select GRTE Sample of a Linear Eesource
q grtspts Select GRTE Sample of a Finite Eesource v
n I:Ej 4§ Iy Cornpuiter




A help file is available for each of the user-available function in spsurvey. For example if
click on cat.analysis the help file to do population survey estimates for categorical data
appears.

A R: Categorical Data Analysis for Probability Survey... E|@\g|

Eile Edit View Favorites Tools Help S

>

QBack - © - [¥] & €0 Osearch JrFavories € v i &H - [
Address | €1CARVR-2.4.00ibraryispsurveyihtmiicat.analysis. html v BGo Links @ -

e

cat. analysis {spsurvey} E. Decumentation

Categorical Data Analysis for Probability
Survey Data

Description

This function organizes mput and output for analysis of categoncal data generated by a probability survey.
Tnput can be either an object belonging to class psurvey analysis (see the documentation for function
paurvey. analysis) or through use of the other arguments to this finction.

Usage

cat.analysis(sites=NULL, subpop=NULL, design=NULL, data.cat=NULL,
N.cluster=NULL, popsize=NULL, stagelsize=NULL, popcorrect=FALIE,
sizeweight=FAL3E, unitsize=NULL, wartype="Local®, conf=95, psurvey.obhj=NULL])

Arguments

sites a data frame consisting of two variables: the first variable is site TD's, and the second
vatiable 15 a logical wector mdicating which sites to use in the analysis. Fpsurvey.obj 15 not

provided, then this argument iz required. The default 15 NTULL.
subpap a data frame describing sets of populations and subpopulations for which estimates will be
calculated. The first wariable is site TD'z. Each subsedquent variable identifies a Type of
population, where the vaniable name 15 used to entify Type. A Type variable identfies
each site with one of the subpopulations of that Type. If psurvey. obj 18 not provided, then
thiz armument iz required. The default 1 TTTTLL. b
&] Done o My Computer
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Installing Tinn-R editor

Tinn-R is a text editor designing to work seamlessly with R. It recognizes R
commands/functions, does automatic matching of parentheses, and has icons that execute
R script you create in Tinn-R. An advantage of using Tinn-R is that you can preserve the
R script you created to do a survey design or survey analysis. If your input data changes,
it is simple to redo an entire analysis without changing any of the R script. The saved
script file can also be used for QA purposes.

To install Tinn-R, double click on Tinn-R_2.3.7.1_setup.exe to begin the Windows Installer.
On the Select Additional Tasks window, you have options to create a desktop icon and a Quick
Launch icon. Check options you prefer. Keep all default file associations.

e Setup - Tinn-R

Select Additional Tasks "
YWhich additional tazks should be perfarmed? e

Select the additional tazkz vou would like Setup to perform while instaling Tinn-R, then
click Mest,

Additional icons: i

[ ] iCreate a desktop icord

Create a Quick Launch icon

Files association:

Azzociate [*.r, “R]- R

Azzociate [F.q. 0] -5

[ ] Associate [*.rd, *Fd] - F help
Azzociate [*.ruw, © Row] - Sweave

[w] szzociate [*.enw, * Shw] - Sweave b

SourceForge/Tinn-R [ < Back ” Mewt » l[ Cancel ]

The installation ends with an option to start Tinn-R. When Tinn-R starts it looks as
follows IF R is not running:

Eile Project Edit Format Search Options Tools B Miew Windows Web Help

0 & - & e 2 a % # [E]=] = : 3
= = L = - |

>
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If R is running, then Tinn-R looks as follows:

File  Project Edit  Format  Search  Options  Tools R Wiew  indow  Web  Help
: O~ 1 @ie? :Q@A%0D:e@F[EFasr DD
of : BB S : - | P
3 O & &) 7| = >

Tinn-R. hotkeys inactive

Note the lowest tool bar has some icons in color. This tool bar is associated with R. By
placing the cursor over each icon information about what clicking the icon does with R is
given.

When open an R script file, other icons on the tool bar become active.

.J File  Project Edit  Format  Search  Options  Tools R Wew  Window Web Help - |58 x
. PR . L
_‘_] P ‘_]Lﬂ.j_a.-"_o_\—&]':--r'._l_ﬁﬁ”’jl:lrlj!'g = oad a1
- A e : - : -V
SR — =34 DG EBEASDES &7 = 9@ >
R_Script_Intro.R |
# File: K Script Intro.R .
# Purpose: Introduce B using Spreadsheet as analogy b
# Programmer: Tony 0lsen
# Date: Octoker 14, 2005
#
# Data reguired: R Spreadsheet.csv
w

Lin 1/62; Cal 1 Marmal mode  smMormal | Size: 1.47 KB Tinn-R. hotkeys inactive

Windows Topics

It is useful to save files from Excel using a tab delimited format to read into R. One
reason is that it is unusual to have a tab in a data file and common to have a “,” appear in
a name. Such commas cause problems when reading a csv file in R. To make it easier to
open tab-delimited files, it is useful to change their file extension to “.tab” and to assign
the “.tab” file extension to be opened by Excel. This can be done using Folder Options
under the Tools pull-down menu.



Folder Options [.5_<|

General | Wiew | File Types | Dffline Files

Reaistered file ypes:

Extenzionz  File Tupes >
SY5 System file
AT Tinn-R
|=] TAB T4B File
TAR UltimateZip Tar File
# TBC  ActiveTcl Script =
TBZ UltimateZip T arBZip2 File
ﬁ?‘T TD=T b=~ T = D701 Tl \_f

Heww ][ Delete ]

Detailz for 'TAR' extenzion

Opens with: @ Microzoft Office Excel

Files with extenzion 'TAB' are of type 'TAB File'. To change
zettings that affect all 'TAR File' files, click Advanced.
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Begin a Survey Design or

Survey Analysis for a Project

e Create a new folder for the survey
design or survey analysis task
e Recommend creation of a subfolder
named “Original Data”
» Place any original data files in this
folder
= Never change these files
e Double click the R desktop icon or quick
launch icon to start R
e Under the R File menu,
= Click Change Dir ...
= Click Browse, scroll to find your
project directory and click on it, then
click OK
e \When done using R, click Exit under the
File menu and click YES when asked
“Save workspace image?”.
e \When you want to start R again to work
on this project, go to its project folder
and open the “.RData” file.
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Executing Commands in R

e Three options to execute commands in R
= Type commands in console window
« Window automatically opens

when R starts
o Commands execute by pressing
the “Enter” key
= Use the script window In R
o Under File menu either create
New or Open existing script file
e Type commands in the script
window
e To execute commands, copy and
paste into the console window
» Close window and save to
project directory
» Use saved script file when you
want to continue work on the
same project
= Use another text editor program
e Type commands in editor
e Copy and paste into the console
window



e Advantages of R script window or text
editor approach

= Can save all your commands in both
cases

= Some text editors recognize R
language and structure making it
easy to locate errors (e.g., Tinn-R)

= Can redo the analysis if there are
changes to the data

= Can set up an example analysis and
use as a template for other analyses

= Aid in QA for analysis process
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Things to remember in R
e Column names may be modified in R

= “planks” will become “.”
= Unusual characters will become “.”
= Unusual character at the beginning
(e.g., %) will change to “X.”
e Blanks in spreadsheet will be turned into
missing data
e “NA” in spreadsheet will be interpreted
as missing data, except when column is
character
e Everything after “#” is ignored, which
can be overridden
e Reading a comma-separated value (csv)
file may result in unanticipated results if
columns contain “,” in character fields
(recommend use of tab-delimited files
Instead)



-
<
w
=
-
.
O
&
L
-
—
p
)
o
<L
<L
o 8
i
2,
-

Downloading R from R-Project Website

Use a web browser to access: http://r-project.org/. Select a CRAN mirror site near your
location. lllustration is from a site in Washington, USA.

File Edit View Favorites Tools Help 'ﬂ’
€] © (%] B @ O Search YrFavorits ) v ix - L 7
Address | @ http: fferan.us r-project.org/ v B Go Links @ -

5

The Comprehensive R
Archive Network

Frequently used pages

CRAN 3
Mirrors Download and Install R
TWhat's new?
Task Views Precompiled binaty distributions of the base system and
Search — contributed packages, Windows and Mac users most likely want
one of these versions of R
About R
E Homepage o Linuz
R o MacOS X
costTare o Windows (95 and later)
4 | = 3
I@l %J Local infranet

Click Windows


http://r-project.org/�

b=
<
L
=
=
O
o
(@]
98
=
—
-
O
(1 4
<
<
Q.
w
2
=

A The Comprehensive R Archive Network - Micrusoft...|jZHEi\g]

File Edit View Favorites Tools Help "
QBack - © - [¥] & €0 Osearch rFavorites €9 (I~ im - L) ”
Address | @ http: fferan.us r-project.org/ v B Go Links @ -

LS

R for Windows

This directory containg binaries for a basze distribution and packages to run on
Windows (NT, 83 and later) on Intel and clones (but not N'T on Alpha and other

platforms).
o
CPRAN i . L
Mirrors Hote: CEAN does not have Windows systems and cannot check these binaries for
What's new? wiruses. Use the normal precavtions with downloaded executables.
Task Views ] -
Search Subdirectories:
bbout R ace Binaries for base distribution {managed by Duncan
E Homepage Murdoch)
contrib Binaries of contributed packages (managed by Uwe Ligges)

software
M Please do not submit binaries to CRAM. Package developers might want to contact
E Binaries Duncan Wurdoch or Uwe Ligges directly in case of questions f suggestions related to
Packages Windows binaries.
Cther 5

. Tou may also want to read the B FAD and B for Windows FAQ.
Documentati
IManuals B
P s Lastmodified: April 4, 2004, by Friedrich Leisch v

I@ Daone %J Local infranet

Click base
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2 The Comprehensive R Archive Network - Micrusoft...E]@i\E]

File Edit ‘iew Favorites Tools Help "
QBack - © - [x] & €0 Oseach SrFavorites €9 (I~ im - LJ
Address | @ http: fferan.us r-project.org/ v Go  Links @ -
5
R-2.4.0 for Windows
This directory containg a binary distribution of E-2.4. 0 to run on Windows 93, 98,
LE, T4.0, 2000 and XP on Intel'clone chips.
CREN Patches to this release are incorporated in the r-patched snapshot build.
Mlrrors . ) ) ) .
What's nevw? A buidd of the development version {which will eventually become the next major
Task Views release of ) 1z avatlable mn the r-devel snapshot budd.
Search o
In this directory:
Bbout R
E. Homepage % Installation and other mstructions.
Software CHAMNGES IMew features of this Windows version.
M HEWS New features of all versions.
E. Binaries .
. E-2.40- Setup program (about 28 megabytes). Please download this
Packages ; .
Other win3a. exe from a mirror near ¥ou. 1
— This corresponds to the file named SetupR.exe or
Document at ion WX XX exe i pre-2.2 0 releases.
lamuals old The previcus release.
FAQ:s mddsumtzt  mdSsum output for the setup program. A Windows G
Contnbuted version of mdSsum 15 avalable at
Mewsletter httpfwrarw mdSsumimer. orgl a Windows command line
wersion i3 avalable at httpJ/fvwarw. etree. org/mdScorm html.
£ ~
I@ %J Local infranet

Click R-2.15.0-win.exe




File Download - Security Warni...gi\

Do you want to run or zave this hle?

D Mame: R-2.4.0-win32,exe
Type: Application, 27.9 ME

Fram: cran.us.r-project.org

Eun ][ Save ] | Cancel |

Wwhile files from the Intemet can be useful, thiz file tppe can
g potentially harm your computer. [F yow do not tugt the gource, do not

run or gave thiz software. What's the risk?

Click Save
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Save i |l.f}ke_l,ls V| < ) ? ¥ (v

ky Recent
Documents

by Documents

9! File narme: | R-2.4.0-win32 exe b | [ Save l

by Computer Cave as hype:

|.-'1‘-.pp|i|:ati|:|n V| [ Cancel ]

Click Desktop
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Save As

Save jn; | @ Deszkiop

e 3
v| OB M~

L My Docurments
( '4) 4 My Computer
: My MNebwork Places
4= Adobe Acrobat 7.0 Professional

Al Adobe Reader 7.0

& Cisco IPTV Viewer
9 otus MNotes 6.5
a5

ky Recent
Documents

Desktop | @ Macromedia Contribute 3
EIMacromedia Dreamweaver &
EDMacromedia Fireworks 8

”/ fMacromedia Flash 8
by Documents @NEECEDE /1

BPRealPlayer
EEls-pLUS 7.0

@ UlraEdit-32
EWinZip

B WordPerfect O
BIBacklp

B Command Prompt
s Dick Cleanup

& ocal Disk (C)

&= ocal Disk (O
MNoteTab Light
i5'R-2.4.0-win32 exe

¥

~ < |
gﬂ File: narme: FI-E.d.I:I-l.-'-.lir'uElE.Ee:-::

b | [ Save l

by Computer Cave as hype:

| Apphcation

v| [ Cancel ]

Click Save
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